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COLTS ATHLETICS IDENTITY

The Canada Athletics Department promotes excellence in athletics and prepares leaders for tomorrow
by providing a positive environment to enable student-athletes to achieve their highest academic,
athletic, and personal aspirations. The Athletics Deparztment is housed in Building 01, Kinesiology
and Wellness.

Canada College competes as a member of the Coast Conference in baseball, women’s soccer, men’s
soccer, women'’s volleyball, women'’s tennis, and basketball; in the Big 8 Conference, Canada College
competes in women'’s golf. A wide variety of activity courses are offered to students and the community
that are designed for lifetime enhancement of fitness, recreation and leisure time.
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BRAND APPROVED LOGOS, FONTS
AND COLORS
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APPROVED ATHLETICS TYPOGRAPHY

Please do not attempt to recreate the Athletics logo—use only the approved artwork and fonts. The
typeface used in the logo is Straczynski, which you may also use for headlines when working on a
printed material. If Straczynski is unavailable , please see complementary fonts section below.

Straczynski Complimentary Fonts
Straczynski Regular ARIAL BOLD
Straczynski Regular Italic ARIAL BOLD ITALICS
Straczynski Bold FUTURA BOLD CONDENSED
Straczynski Bold Italic FUTURA BOLD CONDENSED ITALICS

FUTURA EXTRA BLACK CONDENSED
FUTURA EXTRA BLACK CONDENSED ITALICS
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MAIN ATHLETICS LOGO USE

Our Athletics logo is the key to
properly representing the Colt’s ,l(
Athletic teams at Cafada College. oo L

We must ensure proper usage.

Please observe the clear space
that is around the logo. Nothing
should intrude on this specific
area. When in doubt, please leave
enough room around the logo.

LOLTS:
| )

The preferred logo use is our full-color |

deSIgn : Please use the Whlte |Og0 The logo consists of a custom colt illustration, and modified logo
over darker backgrounds or on type, with roots written in Straczynski font.
Canada Green. No other lcons or

“image branding” should be placed

or used next to any Athletics logo
at any time.

COLTS COLTS COLTS
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INDIVIDUAL TEAM LOGO USE

Our Athletics logo can be formatted
to promote specific athletic teams.
The supporting team’s typography
vary in sizes, but should be less
than or equal to the “open space”
of the illustrated graphic as
indicated.

Please observe the clear space
that is around the logo. Nothing
should intrude on this specific

area. If a curved “Canada College”
version is desired, please download
the correct version on the website,
(canadacollege.edu/athletics/

logos.php) and observe the same

clear space.

&mur - @mwws? &aumiz

Canada College Athletics Style Guide | 7



APPROVED ATHLETICS COLORS

The following colors are approved to use on marketing materials, website assets, clothing, and team
apparel. When designing print or digital materials, the college green should always be the primary color,
while the yellow is an accent color. Please contact the Athletics Director if alternate colors or branding
materials are needed for a special event.

Athletics Primary Colors:

Athletics Green Canada Yellow
Pantone 3435 Pantone 107 C
Pantone 3435 U Pantone Yellow U
CMYK: 87, 45, 72, 51 CMYK: 2,7,95,0
RGB: 32, 92, 64 RGB: 251, 225, 34

COMPLIMENTARY ATHLETICS COLORS

Colt Green Lime Green Iron Grey White

Pantone 369 C Pantone 375 C Pantone 135C
Pantone 356 Pantone 369 U Pantone 375U Pantone 135 U Pantone 4196 U Pantone 428 U CMYK: 0,0,0,0
CMYK: 91,0, 100,26 CMYK:58,0,100,4 CMYK:47,0,100,0 CMYK:O0,18,72,0 CMYK: 63, 55,56,31 CMYK:21,13,8,0 RGB: 255, 255, 255
RGB: 0, 122, 51 RGB: 100, 167, 11 RGB: 141, 205, 61 RGB: 255, 198, 88 RGB: 99, 101, 105 RGB: 193, 198, 200

Pantone 428 C White
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SUGGESTED COLOR COMBINATIONS

Here are some sample color combinations that address the message and tone of Athletics materials.
Black, grey, and white are always accepted accent colors.

Classic Canada: Colt Athletic Pride:
Suggested Design Material Colors: Quick Marketing Material or Flyer:
Non-Competition Apparel: Alternative Jersey:
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INCORRECT LOGO USE

For all college logos and college
seal, DO NOT:

1. Print in a repeat pattern

. Alter or stretch disproportionately

2
3. Change the authorized colors
4

. Use patterned backgrounds 4.
behind the logo

o1

. Change the orientation

0. Add extra effects. This includes
but is not limited to: bevel,

emboss, shadows, glow, etc.
7. Attempt to recreate the logo

8. Make alterations, additions, or
substitutions to the words

9. Display the logo on busy
photography
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LOGO AND SEAL SIZES

Minimum Sizes for Print:

Do not print the logos or seal
smaller than three-quarters of an
inch across.

Canada College
>
.75inch

Minimum Sizes for Web:

On the web, do not use the seal
smaller than 70 pixels across and @

= P
never use the logos less than 130 Canada College TOLTS
pixels across.
For more information on Canada ) 130 Pixels . 70 Pixels 70 Pixels

College logo usage and style guide,
visit: canadacollege.edu/marketing/
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PRINT MATERIALS, WEB/DIGITAL
CONTENT, AND TEMPLATES
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TEMPLATES, HEADERS, AND FOOTERS

In order to facilitate your design time, there are Athletics templates, headers and footers within the
college website. The template sizes and designed footers and headers can all be found on this web
page: canadacollege.edu/kad/templates.php

Templates: For print ease-ability, please try to design in the following sizes: 8.5"x11”, 11"x17”,
18"x24”, and 24”x36”. Place a header and/or footer if needed. Footers are preferred in any design.

Headers and Footers: The following Headers and Footers can be used on any design template (Word,
InDesign, Publisher, lllustrator, FrontPage, etc) to easily maintain our brand on printed materials. They
are provided to you in “.png” format, which is ready to include in your design with a “Clear/transparent”
background. The png file will open in your browser window - right click on it and choose ‘Save Picture As’
and save it to the location of your choice.

Sample Header/Footer:

Canada College

LOLTS
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STATIONERY

Please use the appropriate stationary, whether it is general college or athletics letterhead and envelope.
Align the letter and address as shown below and optically center the address side-to-side on the
envelope.

—1.25 INCH— 2 INCHES —1.25 INCH —

LOLTS

|
|
|
|
|
|
|
|
IRecipient Name |
IStreet Address I
ICity, ST ZIP Code |
I |
1 |
I |
I |
IDear Recipient Name: |

|

|

|

I

ITo get started right away, just tap any placeholder text (such
Ireplace it with your own.

I

IWant to insert a picture from your files or add a shape, text b

:the Insert tab of the ribbon, just tap the option you need.

IFind even more easy-to-use tools on the Insert tab, such as

! v [OLTS
comment.

I

IStyles in this document have been customized to match the
| his page. On the Home tab of the ribbon, check out Styles tq
\need with just a tap.

Canada College Arhletics
4200 Farm Hill Blvd.
Redwood City, CA 94061

IAT LEAST 1/3 INCH

:\ﬁew and edit this document in Word on your computer, tab T T T T T T T T T T Recipient Name
jtext; easily insert content such as pictures, shapes, and tablej Street Address
|document to the cloud from Word on your Windows, Mac, An| City, ST ZIP Code

|

|The envelope attached to this letterhead is formatted for stan
lenvelopes. Before printing your envelope and letter, be sure
lyou want to print on is loaded in your printer.

1

IRemember to double-click the company contact info in the fol
I

ISincerely,
I

I
Your Name
I

Cafiada College Athletics - 4200 Farm Hill Blvd. Redwood City, CA 94061 - (650) 306-3341 - canadacollege.edu
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SCHEDULE/ROSTER TEMPLATES

Team schedules and rosters templates can be found on the college website. The template sizes can be
found on this webpage: canadacollege.edu/kad/templates.php

Cafiada College | WOMEN’S SOCCER
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DIGITAL SCREEN SLIDES/ADS

The Marketing Department coordinates the content displayed on select digital screens around campus,
mainly the screens in Building 1, Building 5 (The Grove), Building 9, and Building 23. The screens in
Building 9 are monitor screen-savers located in the Library and Learning Center. The purpose of

Building 1 screens the is to provide information to the campus community about sporting events,
recruitment opportunities, activities, and to promote COLTS pride. Please design your image in horizontal
format and in dimensions 1920 by 1080 pixels at least one week prior to desired posting date, and then
fill out a Marketing request form for approval at: canadacollege.edu/marketing/requestform.php

Grove Digital Screen and
Computer Monitor Ads

1080 px

1920 x 1080 pixels at 150 dpi (dots per inch);
A PowerPoint, horizontal, widescreen (16:9) slide-size works well

If you need assistance from the Marketing Department to design a digital slide, please complete the
Marketing request form. A lead time of 2-3 weeks before the desired posting date is preferred.
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EXAMPLES OF PRINT MATERIALS

LOLTS

YOUR LOGO

GOES HERE A short intro of two lines of text can fit here.

This is just a sample.

Description:
Ulpa apit optam ut dolorio necabor estotati qui cullaceatem volendis essequate
venimil moluptatur, il iur simusci atiae. Nequo et, omnis exerum que non consedio.
Ut ad quatio beriorest debis nobit re vendae. Itae diae suntur sequo qui dolor sit que
sed qui inis et prepedist, optation raerro beatur?

Other event information:
* Korem ipsum dor sit amet, In sodales risus nibh, sodales risus nibh
* Torem ipsum dolor sit amet, In sodales risus nibh, sodales risus nibhn sodales risus
* Lorem ipsuolor sit amet, In sodales risus nibh, sodales risus nibh ipsum dolor sit
* Borem ipsum dolor sit amet, In sodales risus nibh, sodales risus nibh
* Lorem ipsum dolor sit amet, In sodales risus nibh, sodales risus nibh

canadacollege.edu/kad

Caﬁada/College

First name last name | your@smccd.edu q For disability-related accommodations, please email:
(650) 306-32XX | Building #-### & canvpss@smeed.edu or call (650) 306-3234.

Caﬁada/College

information below”

URILONG T
&0 HERE WE PROVISE.

< Your paragraph of
information goes here.
Sample text has helped
me by providing a wide
variety of resources

from textbook support

to scheduling classes. |
appreciated knowing there
was a support system
behind me that was willing
to answer any questions |
may have.

sUBTITLE GOES HERE:

[> Grounding point 1

More Information to go here.
Students who commit to
attending full-time (12 units
minimum per semester).

[> Grounding point 2
with extra detail as an
example

Motivated students who are
seeking a degree or certificate

> Grounding point 3 with
room for more points if
needed.

.
.
.
.
.
.
.
.
.
.
.
.
.
.
.
.
.
.
.

EVENT NAME & DATE, JANUARY 15, 2020

FOR MORE INFORMATION VISIT YOUR WEBSITE URL.COM OR CONTACT YOUR DEPARTMENT

YOUR EMAIL@smccd.edu | 650-XXX-XXXX
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TEAM UNIFORMS AND

NON-COMPETITION APPAREL
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TEAM UNIFORMS

Team uniforms include everything worn during competition. This is includes, but it not limited to: jerseys,
shorts, pants, socks, hats, helmets. The entire uniform is considered “Competition Apparel”.

Colors: Uniforms should conform to the Athletics color palette. Please try and adhere to the college
green, yellow, and white, with black/grey being alternate or accent colors. One exception are the soccer
teams, which may use bright green alternate uniforms.

Logos and Numbers: A “COLTS” logo or team logo should always appear somewhere on the uniform.

For most sports, a logo in the chest area, upper breast area, or sleeve is sufficient. Script or “classic”
fonts may be used for sports where that is the norm, such as Baseball. Numbers should be high contrast
against college colors, similar to the first two examples. Please avoid low contrast numbers and letters.
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TEAM UNIFORM SAMPLES

Below are sample uniforms across competetive COLTS sports. Please note the consistent use of the

branding, colors, and typography. Please contact the Athletics Director BEFORE ordering alternative team
uniform color combinations.

A N\~

<y o
CANADA

N n

Canada
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NON-COMPETITION APPAREL SAMPLES

Along with clothing, apparel can also include items such as keychains, hats, jewelry, nametags, and
sunglasses. These items are not intended for use or wear during competition.
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QUESTIONS ABOUT THIS GUIDE

There are several options for you and your team to create an attractive and impactful look and style.
Our goals are to facilitate department individuality while still maintaining our Canada College brand,
market our college identity, and make sure that all instructional and promotional material always have
the proper look and message in order to most benefit our students and community.

Should you have questions after consulting these guidelines, please contact the Athletics Department.
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